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本資料は表記のバージ ョ ンの英語版を翻訳したもので、内容に相違が生じる場合には原文を優先します。 資料によっては英語版の更新に対応していないものがあります。 日本
語版は参考用としてご使用の上、 最新情報につきましては、 必ず最新英語版をご参照く ださい。

概要

このアプリ ケーシ ョ ン ノートでは、 Vivado® 高位合成 (HLS) を使用して AXI4-Stream インターフェイス経由で 
Zynq®-7000 All Programmable SoC (AP SoC) デバイスの ARM CPU のアクセラレータ  コ ヒーレンシ ポート  (ACP) へ接続さ
れる浮動小数点行列乗算アクセラレータの開発方法について説明します。

Vivado HLS を使用するこ とで、 C/C++ コードでモデル化された浮動小数点行列乗算アクセラレータをレジスタ転送レベ
ル (RTL) デザインに素早く実装および最適化できます。 ソ リ ューシ ョ ンは IP コアと してエクスポート され、 自動生成さ
れた AXI4-Stream インターフェイスを介して AP SoC Processing Subsystem (PS) の ACP に接続されます。 接続には、
AP SoC Programmable Logic (PL) サブシステムの DMA (Direct Memory Access) コアを使用します。 行列乗算ペリ フェラル、
DMA エンジン、 AXI タイマーなどの AP SoC PL ハードウェアの設計には、 Vivado IP インテグレーター (IPI) を使用しま
す。 ペリ フェラルを管理する  AP SoC PS ソフ ト ウェアの設計にはソフ ト ウェア開発キッ ト  (SDK) を使用します。

このアプリ ケーシ ョ ン ノートの リ ファレンス  デザイン ファ イルは、 ザイ リ ンクスのウェブサイ トからダウンロードでき
ます。 デザイン ファ イルの詳細は、 「 リ ファレンス  デザイン」 を参照して ください。

はじめに

行列乗算は、 応用数学のほとんどすべての演算で使用されています。 たとえば、 最新レーダー システムでは、 受信アン
テナの位相をコンピューター計算でデジタル制御するビームフォーミ ング技術で行列乗算が使用されています。 ザイ リ ン
クスの Vivado HLS ツールを使用するこ とで、 浮動小数点アルゴ リズムを C/C++ コードで素早く記述でき、 Zynq-7000 
AP SoC で最適化して実装できます ([参照 1])。 この方法は、 従来のマイクロプロセッサを用いて浮動小数点アルゴ リズム
を実装する設計者に、 低コス ト、 高性能、 低消費電力といった利点をもたらします ([参照 2]、 [参照 3])。

このアプリ ケーシ ョ ン ノートでは、 32x32 行列の浮動小数点乗算の適用をはじめとする、 ザイ リ ンクス  PL でのデザイン 
フローについて説明します。

1. Vivado HLS を使用して、 C/C++ で記述された浮動小数点デザインを高性能ハードウェア アクセラレータにコンパイ
ルして最適化する。

2. Vivado HLS の C++ テンプレート を使用して、 ハード ウェア アクセラレータの AXI4-Stream インターフェイスを指定
して生成する。

3. Vivado IP インテグレーター [参照 4] を使用して、ハードウェア アクセラレータを AP SoC PL の AXI DMA ペリ フェラ
ルおよび AP SoC PS の ACP に接続する。

4. ARM CPU で動作するソフ ト ウェアを記述してハードウェア アクセラレータの関数呼び出しを含め、 システム レベ
ルの性能を測定する。

図 1 に、 Zynq-7000 デバイスに実装されたシステムのブロ ッ ク図を示します。
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このアプリ ケーシ ョ ン ノートで説明する設計手順は、 Zynq-7000 AP SoC 評価キッ ト  (ZC702) [参照 5] を用い、 Vivado 
2015.4 IDE ツールで設計する場合に適用されます。

Vivado HLS を使用した行列乗算デザイン

行列乗算アルゴ リズム A*B=C は非常にシンプルです。 次の 3 つのネス ト されたループがあ り ます。

• 1 つ目のループ (L1) は、 1 行の入力行列 A を構成する要素を繰り返します。

• 2 つ目のループ (L2) は、 1 列の入力行列 B 内の要素を繰り返します。

• 3 つ目のループ (L3) は、 行ベク トルの各インデッ クスを列ベク トル B のインデッ クス と掛け算し、 それを累算して 
1 行の出力行列 C の要素を生成します。

X-Ref Target - Figure 1

図 1 : Zynq‐7000 AP SoC 上の PS と  PL のパーティシ ョ ン 
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最適化される関数の C++ コードは次のよ うにな り ます。

   template <typename T, int DIM>
   void mmult_hw(T A[DIM][DIM], T B[DIM][DIM], T C[DIM][DIM])
   {
     // matrix multiplication of a A*B matrix
     L1:for (int ia = 0; ia < DIM; ++ia) 
     {
       L2:for (int ib = 0; ib < DIM; ++ib) 
       {
         T sum = 0;
         L3:for (int id = 0; id < DIM; ++id) 
         {
           sum += A[ia][id] * B[id][ib];
         }
       C[ia][ib] = sum;
     }
   }

アルゴ リズムを C++ コードでキャプチャ後に、 Vivado HLS を使用してこれを RTL インプリ メンテーシ ョ ンに合成できま
す。 C++ ソース  コードのほかにも、 Vivado HLS はターゲッ ト  ク ロ ッ ク周波数、 ターゲッ ト  デバイス仕様、 さ らには特定
の最適化を制御および指示するためのユーザー指示子 (コマンド ) を入力と して受けるこ とができます。 Vivado HLS の機
能や特徴を短時間で理解するには、 例を用いて実際に使用してみるこ とです。 Vivado HLS の詳細は、 『Vivado HLS ユー
ザー ガイ ド』 [参照 6] を参照してください。

次の TCL コードは、 ク ロ ッ ク周期と ターゲッ ト  デバイスを示しています。

set_part {xc7z010clg400-1}
create_clock -period 10

mmult_hw 関数のコードを使用する場合、 Vivado HLS は次の動作を実行します。

• C コードで記述されている各動作を同等のハードウェア動作に変換し、 これら動作をクロ ッ ク  サイクルに割り当て
ます。 ク ロ ッ ク周期とデバイス遅延の情報に基づいて、 シングル ク ロ ッ ク  サイクル内にできるだけ多くの動作を割
り当てます。

• インターフェイス合成を使用して、 データがどのよ うにしてハード ウェア ブロ ッ クに送信されて書き込みが実行さ
れるかを自動で合成します。 たとえば、 データが配列と して与えられる場合は、 RAM ブロ ッ ク  (別の I/O インター
フェイス  オプシ ョ ンを指定可能) へアクセスするインターフェイスが自動的に構築されます。

• 各ハードウェア動作を AP SoC 上の同等ハードウェア ユニッ トにマップします。

• 任意のユーザー定義の最適化 (パイプライン動作や並列動作など) を実行します。

• AP SoC に実装するための最終的なデザイン (Verilog および VHDL) をレポート と共に出力します。

サンプル コアのコード合成で生成されたレポートでは、 最初の性能評価 (デフォルトの合成結果) を含む動作や性能が評
価されています。

この例では、 Vivado HLS が C コードで記述された動作を解析し、 指定されたターゲッ ト技術と クロ ッ ク周期で結果を計
算するのに必要なクロ ッ ク  サイ クルが 329,793 である と判断しています。 つま り、 このデザインは、 最大のクロ ッ ク周期 
8.41ns で実行できる と考えられます。

図 2 のエリ ア評価では、 デザインで使用される  PL リ ソース数を示しています (5 DSP48 スライス、 473 FF (フ リ ップフ
ロ ップ)、 830 LUT (ルッ クアップテーブル))。
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これらの値はあ く までも推定値にすぎません。 TRL 合成プロセスでは、 RTL コードをさ らにゲート レベルのコンポーネ
ン トへ変換し、 デバイスに配置配線する必要があ り ます。 ほかにも、 最終的な結果に影響を与えるゲート レベルの最適化
が実行される可能性があ り ます。

X-Ref Target - Figure 2

図 2 : 32 ビッ ト浮動小数点の最初の性能評価
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図 3 に、 インターフェイス合成によって I/O ポートに変換された C 関数の引数を示します。 このプロセスで、 完成したエ
ンベデッ ド  デザインのその他のブロッ クへポートが接続されます。

このプロセスで生じた変更は次のとおりです。

• デザインにクロ ッ ク信号と リセッ ト信号 (ap_clk、 ap_rst) が追加されました。

• デザイン レベルのプロ ト コルが追加されました。 これはデフォルト設定ですが、 変更可能です。 これによ り、 デザ
インの動作開始 (ap_start)、 新しい入力に対応する準備が整っている状態、 動作が完了した状態 (ap_done)、 またはア
イ ドル状態を示すこ とができます。

• 配列引数が、 ザイ リ ンクスのブロ ッ ク  RAM へアクセスするための適切なアドレス信号、 イネーブル信号、 および書
き込み信号を持つ RAM インターフェイスに変換されました。 さ らに、 DIN ポートがデュアルポートのブロ ッ ク  
BRAM (必要に応じてシングルポート  ブロ ッ ク  RAM に設定可能) を使用するこ とで性能が向上する と  Vivado HLS が
自動判断しました。

• Vivado HLS によって、 C コードの動作と  I/O 動作が実装されている  RTL インプリ メンテーシ ョ ンが生成されました。
このと き、 Verilog、 VHDL などの RTL 言語や RTL デザイン全般に関する知識はユーザーに要求されません。

X-Ref Target - Figure 3

図 3 :最初の RTL ポート
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最適化された RTL

HLS で生成された初期デザインは最適化できます。 図 4 では、 3 つの有効なソ リ ューシ ョ ンを比較しています。 行列乗算
の計算に必要なクロ ッ ク  サイ クルを削減するために、 最適化が適用されました。 Vivado HLS による最適化の詳細は、
『Vivado Design Suite チュート リ アル : 高位合成』 [参照 7] を参照してください。

ソ リ ューシ ョ ン 2 は、 初期デザイン (ソ リ ューシ ョ ン 1) よ り約 20 倍高速化されましたが、 使用する リ ソースは増加して
います (10 DSP48 スライス、 2,312 FF、 3,450 LUT)。予測されたクロ ッ ク周期は 9.35ns で、 これは式 1 で算出されるよ うに
出力データ  レートが 6.46 KSPS (千サンプル/秒) とな り ます。

16536 x 9.35ns = 0.154ms = 1 / (6.46 KSPS) 式 1

最も高い性能を示したのは明らかにソ リ ューシ ョ ン 3 で、 浮動小数点の行列乗算を計算するのに必要なクロ ッ ク  サイ ク
ルは、 わずか 1,190 です。 この値は、 160 DSP48 スライス、 13,420 FF、および 23,293 LUT で達成した結果であ り、 AP SoC 
で使用可能な各リ ソースの 72%、 12%、 および 43% にあたり ます。 ソ リ ューシ ョ ン 3 は、 パイプライン初期化インターバ
ルが 1 で、 これはスループッ トが 1 という こ とです。 この例の場合、 データ  レートは 118.9 MSPS (百万サンプル/秒) で、
すべての出力行列は 1,190 x 8.41ns 時間 (10µs) 以内に生成されます。

スループッ ト  1 を達成したという こ とは、 各クロ ッ ク  サイクルで 1 つの行列出力サンプルが生成される という こ とです。
ソ リ ューシ ョ ンの選択はユーザー要件に基づきます。 たとえば、 PL リ ソース重視の観点から、 よ り低コス ト なデザイン
を優先する場合はソ リ ューシ ョ ン 2 を選択できます。

次の TCL コードは、 ソ リ ューシ ョ ン 3 の最適化指示子を示しています。

set_directive_array_partition -type block -factor 16 -dim 2 "mmult_hw" A
set_directive_array_partition -type block -factor 16 -dim 1 "mmult_hw" B
set_directive_pipeline -II 1 "mmult_hw/L2"

X-Ref Target - Figure 4

図 4 : 3 つのソリューシ ョ ンの性能評価の比較
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Vivado HLS の AXI4‐Stream インターフェイス

AXI4-Stream は、 アドレス指定や外部バス  マスターを必要と しないポイン ト間データ転送用の通信規格です [参照 8]。 こ
のプロ ト コルによって、 2 つのコアがプロデューサー /コンシューマー モデルを使用するデータに対して動的に同期しま
す。 使用される  AXI4-Stream のインプリ メンテーシ ョ ンに基づいて、 通信チャネルはワイヤーと して構築されたり、 両端
でのデータ  レートの不一致に対応するためにス ト レージを用いて構築されます。

Vivado HLS で設計された行列乗算コアは、 AXI4-Stream インターフェイスを使用して DMA コン ト ローラーへ接続されま
す。 バース ト  フォーマッティング、 アドレス生成、 メモ リ  ト ランザクシ ョ ンのスケジューリ ングは、 AXI DMA IP で実行
されます。

図 1 に示すシステムのアーキテクチャの場合、ACP ポート を適用して AXI DMA を ARM プロセッサの L2 キャ ッシュへ接
続しています。 また、 別の手段と して、 HP (High Performance) ポート を使用して外部 DDR メモ リへ接続する方法があ り
ます。 Vivado HLS コアからする と、 DMA を介すメモ リ  インターフェイスは、 メモ リが DDR または L2 キャ ッシュのいず
れであっても同じです。 DDR または L2 キャ ッシュのいずれを使用してプロセッサと  Vivado HLS コア間でデータを共有
するかはシステム アーキテクチャの判断です。 DDR は L2 キャ ッシュよ り多くのデータを転送できますが、 通信時のレ
イテンシは L2 キャ ッシュの方が DDR よ り低くな り ます。

Vivado HLS の行列乗算ブロッ クを AXI DMA へ接続するためには、 2 ページの 「Vivado HLS を使用した行列乗算デザイ
ン」 のコードを変更する必要があ り、 このセクシ ョ ンで示す新たに記述した C++ コードのよ うに、 合成される関数をいく
つか追加する必要があ り ます。 具体的には、 AXI4-Stream インターフェイスから要素を抽出する  pop_stream と  
AXI4-Stream インターフェイスへ要素を挿入する  push_stream の 2 つの関数です。 これらの関数は、 行列の 32 ビッ ト浮動
小数点データ と  AXI4 プロ ト コルの 32 ビッ ト符号なしデータ間の変換も実行します。

次に示すコードは、 AXI_VAL データ型の使用法を示しています。 これは、 AXI4-Stream インターフェイスに関連するサ
イ ド  チャネル情報を表すユーザー定義データ型です。 Vivado HLS では、 プロ ト コル ハンドシェイ クに関連しないすべて
のサイ ド  チャネル情報は C/C++ コードで記述され、 何らかの方法で使用される必要があ り ます。 つま り、 Vivado HLS は 
TREADY 信号と  TVALID 信号を抽象化しますが、 AXI4-Stream インターフェイスのその他すべての信号はユーザー コー
ドに含まれる必要があ り ます。 また、 TDATA、 TREADY、 および TVALID 信号を除く、 すべての AXI4-Stream インター
フェイス信号はオプシ ョ ンです。 サイ ド  チャネル信号の使用は、 Vivado HLS AXI4-Stream インターフェイスへ接続された
ブロ ッ クに依存します。
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#include <assert.h>
#include <ap_axi_sdata.h>
typedef ap_axiu<32,4,5,5> AXI_VAL;
template <typename T, int DIM, int SIZE, int U, int TI, int TD>
void wrapped_mmult_hw(AXI_VAL in_stream[2*SIZE], AXI_VAL out_stream[SIZE])
{
  T A[DIM][DIM], B[DIM][DIM], C[DIM][DIM];
assert(sizeof(T)*8 == 32);
// stream in the 2 input matrices
for(int i=0; i<DIM; i++)

   for(int j=0; j<DIM; j++) 
{

 #pragma HLS PIPELINE II=1
   int k = i*DIM + j;
   A[i][j] = pop_stream<T,U,TI,TD>(in_stream[k]);
  }
for (int i=0; i<DIM; i++)
for (int j=0; j<DIM; j++) 
{

 #pragma HLS PIPELINE II=1
int k = i*DIM + j + SIZE;

 B[i][j] = pop_stream<T,U,TI,TD>(in_stream[k]);
  }

 // do multiplication
 mmult_hw<T, DIM>(A, B, C);
// stream out result matrix
for (int i=0; i<DIM; i++)

  for (int j=0; j<DIM; j++) 
  {
 #pragma HLS PIPELINE II=1
 int k = i*DIM + j;
 out_stream[k] = push_stream<T,U,TI,TD>(C[i][j], k==1023);

}
}
// this is the top level design that will be synthesized into RTL
void HLS_accel(AXI_VAL INPUT_STREAM[2048], AXI_VAL OUTPUT_STREAM[1024])
{
  // Map ports to Vivado HLS interfaces
 #pragma HLS INTERFACE s_axilite port=return bundle=CONTROL_BUS

#pragma HLS INTERFACE axis port=INPUT_STREAM
 #pragma HLS INTERFACE axis port=OUTPUT_STREAM
  
 wrapped_mmult_hw<float,32,32*32,4,5,5>(INPUT_STREAM, OUTPUT_STREAM);
}
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図 5 に、 AXI4-Stream 行列乗算の合成レポート を示します。 この時点のレイテンシは、 4,267 ク ロ ッ ク  サイクルであるこ
とに留意して ください。 合計レイテンシの値は、 各行列をアクセラレータから転送したり、 アクセラレータへ転送する時
間、 演算の時間、 およびハードウェア関数のセッ ト アップにかかる時間を考慮に入れて計算されます。 各行列の転送時間
は、 1,024 の 32 ビッ トの浮動小数点値で 1,024 ク ロ ッ ク  サイ クルであるため、 合計時間は 3,072 ク ロ ッ ク  サイクルとな り
ます。 行列乗算の計算時間は 1,188 ク ロ ッ ク  サイクルであ り、 それに pop_stream 関数と  push_stream 関数用に 2 サイクル
が追加されます。 その他、 FOR ループのプロローグ/エピローグおよび関数のスタート アップに多少のクロ ッ ク  サイクル
が必要になり ます。 結果と して、 関数の初期化インターバル (II) は 4,268 ク ロ ッ ク  サイクルで、 レイテンシが 4,267 ク
ロ ッ ク  サイクルとな り ます。

全体的な リ ソース使用数の概算は、 66 BRAM18K (18K ビッ ト容量のブロ ッ ク  RAM)、 160 DSP48 スライス、 13,659 FF、 お
よび 23,789 LUT とな り、 Zynq-7000 で使用可能な各リ ソースの 23%、 72%、 12%、 および 44% にあたり ます。 データ  
レートは 118.9 MSPS のままで、 すべての出力行列は 4,268 x 8.41ns 時間 (36µs) 以内に生成されます。

X-Ref Target - Figure 5

図 5 : AXI4‐Stream 行列乗算コアの合成評価
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Vivado HLS プロジェク トは、 図 6 に示す Vivado HLS Command Prompt シェルを使用して、 デザイン アーカイブで提供さ
れている  TCL スク リプ ト を次のコマンドで実行する と作成できます。

vivado_hls -f run_hls_script.tcl 

64 ビッ トの AXI4-Stream インターフェイスを使用するこ とで、 システム レベルの性能をさらに向上させるこ とができま
す。 この場合、 アクセラレタ  レイテンシは 4,267 サイクルから約 2,700 サイクルに削減されます (図 4 に示すループ L1、
L2、 および L4 のサイ クルが半分になる )。

AXI DMA の概要

AXI DMA コア [参照 9] は、 AXI4-Stream インターフェイスを介すメモ リ とペリ フェラル間に高帯域幅のダイレク ト  メモ
リ  アクセスを提供します。 このコア デザインには次の AXI4 インターフェイスがあ り ます。

• AXI4-Lite スレーブ

• AXI4 メモ リ  マップ読み出しマスター /書き込みマスター

• オプシ ョ ンの AXI4 メモ リ  マップ スキャ ッ ター /ギャザー 読み出し /書き込みマスター

• AXI4 to AXI4-Stream (MM2S) ス ト リーム マスター

• AXI4-Stream to AXI4 (S2MM) ス ト リーム スレーブ

• AXI 制御 AXI4-Stream マスター

• AXI ステータス  AXI4-Stream スレーブ

図 7 に、 AXI DMA インターフェイス とデータ  ス ト リーミ ングを示します。 AXI DMA には 2 つの異なる動作モード  (ス
キャ ッ ター /ギャザー モード、 シンプル DMA モード ) があ り、 同時に両方は使用できません。 各モードには、 AXI4-Lite 
スレーブ インターフェイスを使用して設定された適切なレジスタがあ り ます。 こ こで示すインプリ メンテーシ ョ ンでは、
シンプル DMA モードを使用しています。

X-Ref Target - Figure 6

図 6 : TCL スクリプ ト を実行して Vivado HLS プロジェク ト を作成

• • • • • • •• • • • • •
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シンプル DMA モードは MM2S および S2MM チャネル上でシンプルな DMA 転送を実行するためのコンフ ィギュレーシ ョ
ンで、 使用する  FPGA リ ソース量を抑えるこ とができます。 AXI4 Read (MM2S) インターフェイスがマスター外部メモ リ
からデータを読み出して、 その後 DMA Data Mover が AXI4-Stream (MM2S) ポート を介してそのデータをスレーブ ペリ
フェラルへ転送します。 同様に、 マスター ペリ フェラルは AXI4 Write (S2MM) インターフェイスへデータを送信し、 そ
の後、 AXI4-Stream (S2MM) ポート を介してそのデータをスレーブ外部メモ リに書き込みます。

X-Ref Target - Figure 7

図 7 : AXI DMA コアのブロック図
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DMA 転送は、 制御、 ソース、 またはデスティネーシ ョ ン アドレス とレングス  レジスタを使用して開始されます。 MM2S 
チャネルのセッ ト アップ シーケンスは次のとおりです。

1. 制御レジスタの run/stop ビッ ト を設定して、 MM2S チャネルの実行を開始します。

2. 有効なソース  アドレスが MM2S ソース  アドレス  レジスタに書き込まれます。

3. 転送されるバイ ト数が MM2S レングス  レジスタに書き込まれます。 レングス  レジスタは最後に書き込む必要があ り
ます。

S2MM チャネルのセッ ト アップ シーケンスは次のとおりです。

1. 制御レジスタの run/stop ビッ ト を設定して、 S2MM チャネルの実行を開始します。

2. 有効なデスティネーシ ョ ン アドレスが S2MM デスティネーシ ョ ン アドレス  レジスタに書き込まれます。

3. 受信バッファーのバイ ト長が S2MM レングス  レジスタに書き込まれます。 レングス  レジスタは最後に書き込む必要
があ り ます。

ARM ACP の概要

ACP ポートは、 スヌープ制御ユニッ ト  (SCU) の 64 ビッ ト  AXI スレーブ インターフェイスで、 Zynq-7000 AP SoC PL と  
Cortex-A9 CPU プロセッサ サブシステムを直接接続し、 キャ ッシュ  コ ヒーレン ト な非同期アクセス  ポイン ト と して機能
します。 この ACP ポートは、 PS と  PL に実装されたアクセラレータ間に低レイテンシ パスを提供します。 システム内の
あらゆる  PL マスターは、 このインターフェイスを介するこ とで、 プロセッサと同じよ うにキャ ッシュおよびメモ リ  サブ
システムへアクセスできるため、 実行するソフ ト ウェア アプリ ケーシ ョ ンの全体的なシステム性能を向上させるこ とが
できます。

ACP を経由したコ ヒーレン ト なメモ リ領域への読み出し ト ランザクシ ョ ンは、 SCU と連携して必要なデータがプロセッ
サの L1 キャ ッシュに格納されているかど うかを確認します。 L1 キャ ッシュに必要な情報がある場合、 データは要求元の
コンポーネン トに直接返されます。 情報が L1 キャ ッシュにない場合は、 L2 キャ ッシュにも ヒ ッ ト しなければト ランザク
シ ョ ンは最後にメ イン メモ リに転送されます。 コ ヒーレン ト なメモ リ領域に対する書き込みト ランザクシ ョ ンの場合、
書き込みがメモ リ  システムに転送される前に SCU がコ ヒーレンシを強制します。 オプシ ョ ンで ト ランザクシ ョ ンを  L2 
キャ ッシュに割り当てるこ とができ、 オフチップ メモ リへの書き込み動作によって生じる消費電力や性能への影響を回
避できます。 図 8 に、 ACP と  CPU へ接続されたメモリ  システム間の接続を示します。
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Vivado IP インテグレーターのデザイン

このセクシ ョ ンでは、 ZC702 ボードをベースにザイ リ ンクスの Vivado 2015.4 を使用してハード ウェア デザインを作成す
る手順を説明します。 以前のバージ ョ ン (2013.3、 2014.4、 2015.2) でも同様の手順を適用できます。

すべてデフォルト設定を選択して、 基本の Vivado プロジェク ト  (project_1) を作成します。 デバイスを指定する画面では、
ZC702 ボードを選択します。 詳細手順は次のとおりです。

1. Vivado を起動します。 作業ディ レク ト リ  (xapp1170/empty/vivado) に新規プロジェク ト を作成して、 次を選択し
ます。

° RTL プロジェク ト

° ソース、 IP、 制約は不要 (現段階では)

2. [Default Part] で、 [Boards] → [Zynq-7 ZC702 Evaluation Board] を選択します。

3. [Next] → [Finish] をク リ ッ ク します。 空のプロジェク トで Vivado GUI が表示されます。

X-Ref Target - Figure 8

図 8 : ARM メモリ と  ACP の接続
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IP リ ポジ ト リに HLS IP を追加 : 

1. Flow Navigator の [Project Manager] で [IP Catalog] を選択します (図 9 参照)。

2. [IP Catalog] ウ ィンド ウを表示して、 [IP Settings] をク リ ッ ク します (図 10 参照)。

3. [Repository Manager] で [Add Repository] をク リ ッ ク します。

4. [IP Repositories] ダイアログ ボッ クスで次を実行します。

a. [Create New Folder] アイコンをク リ ッ ク します。

b. 表示されたダイアログ ボッ クスに 「vivado_ip_repo」 と名前を入力します (図 11 参照)。

c. [OK] をク リ ッ ク して、 [Create New Folder] ダイアログ ボッ クスを閉じます。

X-Ref Target - Figure 9

図 9 : IP カタログの起動

X-Ref Target - Figure 10

図 10 : IP カタログの設定を表示 

• • • • • • •• • • • • •
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5. [User Repository] を右ク リ ッ ク します (この時点では空)。

a. [Add IP to Repository] を選択します。

b. [Select IP to Add to Repository] ダイアログ ボッ クスで、
hls/hls_wrapped_mmult_prj/solution0/impl/ip/ を参照します。

c. xilinx_com_hls_HLS_accel_1_0.zip ファ イルを選択します (図 12 参照)。

X-Ref Target - Figure 11

図 11 :新規の IP リポジト リを作成 

X-Ref Target - Figure 12

図 12 : リポジト リに HLS IP を追加
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d. [OK] をク リ ッ ク します。これで [IP Catalog] に Vivado HLS IP が追加されているこ とを確認できます (図 13 参照)。

7. [OK] をク リ ッ ク してダイアログ ボッ クスを閉じます。

X-Ref Target - Figure 13

図 13 : HLS IP が追加された IP カタログ

• • • • • • •• • • • • •
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IP インテグレーターでブロ ッ ク図を設計 : 
(詳細は、 UG995 [参照 4] を参照して ください。 )

1. Flow Navigator の [IP Integrator] の下にある  [Create Block Design] をク リ ッ ク します。

a. 表示されたダイアログ ボッ クスに、 「system」 とデザイン名を入力します (図 14 参照)。

b. [OK] をク リ ッ ク します。

c. 画面右上に、 空の [Diagram] ウ ィンド ウが表示されます (図 15 参照)。

2. ブロ ッ ク  デザインを自動で構築するためのスク リプ トがあらかじめ用意されています。 [TCL Console] に 「source 
2015v4_ipi_xapp1170_bd.tcl」 と入力して、 Enter キーを押します。

3. スク リプ ト終了後、 [Diagram] ウ ィンド ウで右ク リ ッ ク して [Regenerate Layout] を選択します。 図 16 に示すブロ ッ ク
図が表示されます。

X-Ref Target - Figure 14

図 14 : [Create Block Design] ダイアログ ボックス

X-Ref Target - Figure 15

図 15 : [Diagram] ウインドウ

• • • • • • •• • • • • •
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4. [Address Editor] ウ ィンドをク リ ッ ク して、 デザイン内のすべてのスレーブのメモリ  マップを表示します。 マップさ
れていないスレーブがないこ とを確認します。 マップされていないスレーブがある場合は、 [Address Editor] 上で右ク
リ ッ ク して [Auto Assign Address] を選択します (詳細は、 UG994 [参照 10] の第 3 章を参照)。 結果のアドレス  マップ 
テーブルは、 図 17 のよ うにな り ます。

X-Ref Target - Figure 16

図 16 : ブロック  デザイン

X-Ref Target - Figure 17

図 17 : アドレス マップ テーブル

• • • • • • •• • • • •
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5. processing_system7_1 ブロ ッ クで [Presets] をク リ ッ ク して、図 18 に示すよ うに ZC702 がすでに Current Preset で
あるこ とを確認します。

6. [Clock Configuration] → [PL Fabric Clocks] をク リ ッ ク して、 図 19 に示すよ うに FCLK_CLK0 が 100MHz に設定されて
いるこ とを確認します。

X-Ref Target - Figure 18

図 18 : Current Preset: ZC702

X-Ref Target - Figure 19

図 19 : Zynq‐7000 PL FCLK_CLK0 の設定

• • • • • • •• • • • • •
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7. [PL-PS Interrupt Ports] が図 20 に示すよ うに設定されているこ とを確認します。

8. ツールバーの [Validate Design] をク リ ッ ク して、 ブロ ッ ク  デザインを検証します (図 21 参照)。

X-Ref Target - Figure 20

図 20 : PL‐PS 割り込みポートの設定

X-Ref Target - Figure 21

図 21 :デザイン検証
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9. 検証プロセス完了後、 メニューの [File] → [Save Block Design] (または Ctrl + S キー ) を使用してブロ ッ ク  デザインを
保存します。

出力ファイルの生成 : 

1.  [Project Manager] の [Sources] ビューで system.bd を右ク リ ッ ク して [Generate Output Products] をク リ ッ ク します 
(図 22 参照)。

2. 表示されたダイアログ ボッ クスで [OK] をク リ ッ ク して、 すべての出力ファイルの生成を開始します。

3. HDL ラ ッパーを作成します。

a. [Project Manager] の [Sources] ビュー (前の手順と同じ手順およびメニュー ) で system.bd を右ク リ ッ ク して 
[Create HDL Wrapper] をク リ ッ ク します。

b. [OK] をク リ ッ ク して通知メ ッセージを消去します。

4. [Generate Bitstream] をク リ ッ ク します。

X-Ref Target - Figure 22

図 22 :出力ファイルの生成
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5. SDK 用にハードウェア プラ ッ ト フォームをエクスポート して、 SDK を起動します (図 23 参照)。 [Export Hardware] が
選択されているこ とを確認します。 [Include bitstream] はオンにします。

X-Ref Target - Figure 23

図 23 :ハードウェアのエクスポート
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SDK を使用する  Zynq ソフ トウェア デザイン  

[Launch SDK] をク リ ッ ク します (図 23 参照)。 SDK が開く と、 ソフ ト ウェア プロジェク ト を開始できます。 Hello World ア
プリ ケーシ ョ ンを作成するには、 次の手順に従います。

1. [File] → [New] → [Application Project] をク リ ッ ク して新規プロジェク ト を作成し、 [Project name] に 「mmult」 と入力
します (図 24 参照)。

2. [Board Support Package} で [Create New] をク リ ッ ク します。

3. [Next] をク リ ッ ク します。

4. [Hello World] を選択します。

5. [Finish] をク リ ッ ク します。 この手順で、 mmult スタンドアロン アプリ ケーシ ョ ンが作成および構築されます。

X-Ref Target - Figure 24

図 24 : SDK の New Project ウィザード
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6. 出力用にターミナルを使用するため、 ターミナル アプリ ケーシ ョ ン (または SDK のビルト イン ターミナル) を起動し
て、 図 25 のよ うに設定します。

7. 右ク リ ッ クで [Xilinx Tools] → [Program FPGA] を選択して、 Zynq-7000 デバイスをプログラムします。

X-Ref Target - Figure 25

図 25 : UART Terminal の設定
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8. 図 26 に示すよ うに、 [Build Configurations] を [Release] モードに設定します。

X-Ref Target - Figure 26

図 26 : アクテ ィブ コンフ ィギュレーシ ョ ンの設定

• • • • • • •• • • • • •
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9. ボードでこのアプリ ケーシ ョ ンを実行するために、 右ク リ ッ クで [Run] → [Run Configurations] を選択して新しい実行
コンフ ィギュレーシ ョ ンを作成します。 GUI では、 [Xilinx C/C++ application (System Debugger)] を選択して [New] をク
リ ッ ク  (またはエン ト リ をダブルク リ ッ ク ) します。 これで、 新しいコンフ ィギュレーシ ョ ンが生成されます。 図 27 
に示すデフォルト設定を使用して ください。

10. アプリ ケーシ ョ ンを実行します。 ターミナルに 「Hello World」 と表示されます。

X-Ref Target - Figure 27

図 27 : SDK の [Run Configurations]
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次に、 HLS で生成された HW アクセラレータを呼び出すソフ ト ウェアを作成します。 arm_sw フォルダーには、 DMA 
の初期化、 性能の測定、 ハード ウェア アクセラレータの呼び出しを実行する  3 つの C コード  アプリ ケーシ ョ ン  ファ イ
ルが含まれています。 残りのすべてのアプ リ ケーシ ョ ン  ファ イルは、 Vivado HLS で自動生成されて SDK でインポート
されます。

1. helloworld.c ファ イルは、 必要ないので削除できます。

2. 行列乗算の C ファ イルを追加します。

a. mmult プロジェク トで src を右ク リ ッ ク します。

b. [Import] をク リ ッ ク します。

c. [General] を選択します。

d. [File System] を選択して [Next] をク リ ッ ク します。

e. arm_sw ローカル ファ イル システムを選択して、 3 つのファイルを選択します (図 28 参照)。
X-Ref Target - Figure 28

図 28 : ARM CPU 用のファイルをインポート
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3. アプリ ケーシ ョ ンを実行する前にスタ ッ ク  サイズを変更する必要があ り ます (図 29 参照)。

a. [Project Explorer] の mmult/src にある  lscript.ld ファ イルをダブルク リ ッ ク します。

b. [Stack Size] を [0x2000] から  [0x3000] に変更します。

c. ファ イルを保存します。

4. ボード上このアプリ ケーシ ョ ンを実行するために、 右ク リ ッ クで [Run] → [Run Configurations] を選択して新しい実行
コンフ ィギュレーシ ョ ンを作成します。 GUI で [Xilinx C/C++ application (System Debugger)] を選択して [New] をク
リ ッ ク  (またはエン ト リ をダブルク リ ッ ク ) します。 これで、 新しいコンフ ィギュレーシ ョ ンが生成されます。 デ
フォルト設定を使用して ください。

X-Ref Target - Figure 29

図 29 : スタ ック  サイズの変更
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5. アプリ ケーシ ョ ンを実行します。 図 30 にターミナルの出力画面を示します。

X-Ref Target - Figure 30

図 30 : ZC702 ボードでアプリケーシ ョ ンを実行した場合のターミナル出力画面

• • • • • • •• • • • • •
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ザイ リ ンクスの SDSoC は、 Zynq-7000 AP SoC プラ ッ ト フォーム ([参照 11]) を使用してヘテロジニアスなエンベデッ ド  シ
ステムをインプリ メン トするための Eclipse ベースの統合開発環境です。 SDSoC 環境には、 プログラマブル ロジッ クでの
ソフ ト ウェア アクセラレーシ ョ ンの自動化やシステム コネクティビティの自動生成機能などを実行し、 システム全体の
最適化を行う  C/C++ コンパイラが含まれます。 アプリ ケーシ ョ ンは C/C++ コードで記述され、 プログラマがターゲッ ト  
プラ ッ ト フォームとハード ウェアにコンパイルするアプリ ケーシ ョ ン内の関数のサブセッ ト を特定します。 その後、
SDSoC システム コンパイラによ りアプリ ケーシ ョ ンがハード ウェアと ソフ ト ウェアにコンパイルされ、 ファームウェア、
オペレーティング システム、 アプリ ケーシ ョ ン実行ファイルを含むブート  イ メージを含めた完全なエンベデッ ド  システ
ムが Zynq デバイスにインプリ メン ト されます ([参照 12])。

IPI、 HLS、 SDK ツールを使用して、 このアプリ ケーシ ョ ンをゼロから開発する場合は約 2 日かかり ますが、 SDSoC を使
用すれば 1 時間以内で完成させるこ とができます (図 31 参照)。

X-Ref Target - Figure 31

図 31 :行列乗算アプリケーシ ョ ンの SDSoC プロジェク ト

http://japan.xilinx.com
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C または C++ で記述された浮動小数点デザインを FPGA デバイスに素早く簡単に実装できるよ うにな り ました。 このよ
うにデザインを実装するこ とで、 FPGA が持つ並列処理性能、 低消費電力、 組み込まれた CPU、 低コス ト など、 さまざま
な利点をいかすこ とができます。 その他の C/C++ フローと同様に、 完全なツール チェーンでフロー全体をとおして包括
的な解析を行う こ とで性能のト レードオフを可能にします。 サンプル アプリ ケーシ ョ ンは、 Vivado HLS ツールを使用し
て 32 ビッ トの浮動小数点精度に最適化された 32x32 行列乗算コアです。

C/C++ コードでモデル化された浮動小数点行列乗算は、 Vivado HLS で、 RTL デザインに素早く実装および最適化できま
す。 その後、 IP コアと してエクスポートでき、 Zynq-7000 AP SoC PL サブシステムの DMA コアを用い、 AXI4-Stream イン
ターフェイスを介して Zynq-7000 AP SoC PS の ACP に接続されます。

100MHz ク ロ ッ ク周波数で動作する行列乗算ハードウェア ペリ フェラルは、 666MHz ク ロ ッ ク周波数で動作する  ARM 
CPU でソフ ト ウェアを実行するよ り も約 5 ク ロ ッ ク  サイクル早く演算を実行します。

最後に、 このアプリ ケーシ ョ ン ノートで説明した設計手順は、 SDSoC という新しいシステム デザイン フローを使用する
こ とで、 すべて自動化できます。

リファレンス デザイン

このアプリ ケーシ ョ ン ノートの リ ファレンス  デザインは、 次のリ ンクからダウンロードできます。

https://secure.xilinx.com/webreg/clickthrough.do?cid=343614

次の 2 つのフォルダーがあ り ます。

• empty - HLS および IPI プロジェク ト を最初から構築するための C++ コードおよび TCL スク リプ トが含まれます。

• pre_built - 開発済みの HLS および IPI プロジェク トが含まれます。

表 1 に、 リ ファレンス  デザインの詳細を示します。

表 1 : リファレンス デザインの詳細

パラメーター 説明

一般

開発者 Daniele Bagni、 Antonello Di Fresco (ザイ リ ンクス)

ターゲッ ト  デバイス Zynq-7000 AP SoC

ソース  コードの提供 あ り

ソース  コードの形式 C および合成スク リプ ト

既存のザイ リ ンクス  アプリ ケーシ ョ ン ノート / リ ファレ
ンス  デザイン、 またはサードパーティからデザインへ
のコード /IP の使用

なし

シ ミ ュレーシ ョ ン

論理シ ミ ュレーシ ョ ンの実施 あ り

タイ ミ ング シ ミ ュレーシ ョ ンの実施 なし

論理シ ミ ュレーシ ョ ンおよびタイ ミ ング シ ミ ュレー
シ ョ ンでのテス トベンチの利用

あ り

テス トベンチの形式 C

使用したシ ミ ュレータ /バージ ョ ン Vivado シ ミ ュレータ  2015.4

SPICE/IBIS シ ミ ュレーシ ョ ンの実施 なし

http://japan.xilinx.com
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注記 :日本語版のバージ ョ ンは、 英語版よ り古い場合があ り ます。

1. 『Zynq-7000 All Programmable SoC : コンセプ ト、 ツール、 テクニッ ク  ガイ ド  (CTT)』 (UG873 : 英語版、 日本語版)

2. 「Floating-Point Design with Xilinx's Vivado HLS」 James Hrica、 Xcell Journal (2012 年 第 4 四半期) 
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語版)
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改訂履歴

次の表に、 この文書の改訂履歴を示します。

使用したインプリ メンテーシ ョ ン ツール/バージ ョ ン Vivado Design Suite 2015.4

スタティ ッ ク  タイ ミ ング解析の実施 あ り

ハード ウェア検証

ハードウェア検証の実施 あ り

使用したハード ウェア プラ ッ ト フォーム ザイ リ ンクス  ZC702 ボード

表 1 : リファレンス デザインの詳細 (続き)

パラメーター 説明

日付 バージョ ン 内容

2016 年 1 月 21 日 2.0 Vivado 2015.4 に基づいて リ リース

2013 年 6 月 29 日 1.1 Vivado HLS 2012.2 および PlanAhead (ISE/XPS/SDK) 14.4 に基づいて リ リース  
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http://www.xilinx.com/cgi-bin/docs/rdoc?v=latest;d=ug871-vivado-high-level-synthesis-tutorial.pdf
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http://japan.xilinx.com/support/documentation/ip_documentation/axi_ref_guide/latest/ug761_axi_reference_guide.pdf
http://japan.xilinx.com/support/documentation/ip_documentation/axi_ref_guide/latest/ug761_axi_reference_guide.pdf
http://www.xilinx.com/cgi-bin/docs/rdoc?v=latest+ise;d=ug873-zynq-ctt.pdf
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http://japan.xilinx.com/support/documentation/sw_manuals/xilinx2015_4/ug995-vivado-ip-subsystems-tutorial.pdf
http://japan.xilinx.com/support/documentation/boards_and_kits/zc702_zvik/ug850-zc702-eval-bd.pdf
http://japan.xilinx.com/cgi-bin/docs/ipdoc?c=axi_dma;v=latest;d=pg021_axi_dma.pdf
http://japan.xilinx.com/cgi-bin/docs/ipdoc?c=axi_dma;v=latest;d=j_pg021_axi_dma.pdf
http://www.xilinx.com/cgi-bin/docs/rdoc?v=latest;d=ug994-vivado-ip-subsystems.pdf
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http://japan.xilinx.com/support/documentation/sw_manuals/xilinx2015_4/ug994-vivado-ip-subsystems.pdf
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx2015_4/ug1027-sdsoc-user-guide.pdf
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法的通知
本通知に基づいて貴殿または貴社 (本通知の被通知者が個人の場合には 「貴殿」、 法人その他の団体の場合には 「貴社」。 以下同じ ) に開

示される情報 (以下 「本情報」 といいます) は、 ザイ リ ンクスの製品を選択および使用するこ とのためにのみ提供されます。 適用される

法律が許容する最大限の範囲で、 (1) 本情報は 「現状有姿」、 および全て受領者の責任で (with all faults) という状態で提供され、 ザイ リ ン

クスは、 本通知をもって、 明示、 黙示、 法定を問わず (商品性、 非侵害、 特定目的適合性の保証を含みますがこれらに限られません)、
全ての保証および条件を負わない (否認する ) ものと します。 また、 (2) ザイ リ ンクスは、 本情報 (貴殿または貴社による本情報の使用を

含む) に関係し、 起因し、 関連する、 いかなる種類 ・ 性質の損失または損害についても、 責任を負わない (契約上、 不法行為上 (過失の場

合を含む)、 その他のいかなる責任の法理によるかを問わない) ものと し、 当該損失または損害には、 直接、 間接、 特別、 付随的、 結果

的な損失または損害 (第三者が起こした行為の結果被った、 データ、 利益、 業務上の信用の損失、 その他あらゆる種類の損失や損害を含

みます) が含まれるものと し、 それは、 たとえ当該損害や損失が合理的に予見可能であったり、 ザイ リ ンクスがそれらの可能性について

助言を受けていた場合であったと しても同様です。 ザイ リ ンクスは、 本情報に含まれるいかなる誤り も訂正する義務を負わず、 本情報

または製品仕様のアップデート を貴殿または貴社に知らせる義務も負いません。 事前の書面による同意のない限り、 貴殿または貴社は

本情報を再生産、 変更、 頒布、 または公に展示してはなり ません。 一定の製品は、 ザイ リ ンクスの限定的保証の諸条件に従う こ と とな

るので、 http://japan.xilinx.com/legal.htm#tos で見られるザイ リ ンクスの販売条件を参照して下さい。 IP コアは、 ザイ リ ンクスが貴殿また

は貴社に付与したライセンスに含まれる保証と補助的条件に従う こ とにな り ます。 ザイ リ ンクスの製品は、 フェイルセーフと して、 ま

たは、 フェイルセーフの動作を要求するアプリ ケーシ ョ ンに使用するために、 設計されたり意図されたり していません。 そのよ うな重

大なアプリ ケーシ ョ ンにザイ リ ンクスの製品を使用する場合のリ スク と責任は、 貴殿または貴社が単独で負う ものです。

http://japan.xilinx.com/legal.htm#tos で見られるザイ リ ンクスの販売条件を参照してください。

自動車用のアプリ ケーシ ョ ンの免責条項

ザイ リ ンクスの製品は、 フェイルセーフと して設計されたり意図されてはおらず、 また、 フェイルセーフの動作を要求するアプリ ケー

シ ョ ン (具体的には、 (I) エアバッグの展開、 (II) 車のコン ト ロール (フェイルセーフまたは余剰性の機能 (余剰性を実行するためのザイ リ

ンクスの装置にソフ ト ウェアを使用するこ とは含まれません) および操作者がミ スをした際の警告信号がある場合を除きます)、 (III) 死亡

や身体傷害を導く使用、 に関するアプリ ケーシ ョ ン) を使用するために設計されたり意図されたり も していません。 顧客は、 そのよ うな

アプ リ ケーシ ョ ンにザイ リ ンクスの製品を使用する場合のリ スク と責任を単独で負います。

© Copyright 2013-2016 Xilinx, Inc. Xilinx、 Xilinx のロゴ、 Artix、 ISE、 Kintex、 Spartan、 Virtex、 Vivado、 Zynq、 およびこの文書に含まれる

その他の指定されたブランドは、 米国およびその他各国のザイ リ ンクス社の商標です。 すべてのその他の商標は、 それぞれの保有者に

帰属します。

この資料に関するフ ィードバッ クおよびリ ンクなどの問題につきましては、 jpn_trans_feedback@xilinx.com まで、 または各ページの右下

にある  [フ ィードバッ ク送信] ボタンをク リ ッ クする と表示されるフォームからお知らせください。 フ ィードバッ クは日本語で入力可能

です。 いただきましたご意見を参考に早急に対応させていただきます。 なお、 このメール アドレスへのお問い合わせは受け付けており

ません。 あらかじめご了承ください。
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